AMPROBE DM-II™ for Windows

A Data Analysis Program for the DM-II™ Data Logger/Recorder

Operating Manual
# Table of Contents

- **DM-ii™ EXPLORER WINDOW** .................................................. 2
- **EDITING THE EXPLORER WINDOW** .......................................... 4
- **DOWNLOADING DATA FROM THE DM-ii™** .................................. 5
- **STATUS BAR** ........................................................................ 6
- **DOWNLOAD DATASET** .............................................................. 7
- **REPAIRING A BAD DATABASE** .................................................. 9
- **LOAD DATASET FROM FILE** ................................................... 9
- **FOLDER BOX POPUP** .............................................................. 10
- **PARAMETER LIST BOX POPUP** .............................................. 11
- **TOOL BAR** .......................................................................... 12
- **TOOL TIPS** ........................................................................ 12
- **MENU BAR** .......................................................................... 13
- **FILE MENU** ......................................................................... 14
- **VIEW MENU** ...................................................................... 16
- **DM-ii™ MENU** .................................................................... 16
- **TOOLS MENU** ..................................................................... 17
- **WINDOW MENU** .................................................................. 17
- **HELP MENU** ........................................................................ 18
- **CREATING A CHART** ............................................................ 19
- **CHART INFORMATION** .......................................................... 20
- **CHART PROPERTIES** ............................................................. 21
- **DATA SHEET** ...................................................................... 25
- **USER DEFINED PROFILES** .................................................... 26
- **OPTIONS** ........................................................................... 28
- **DMIIVIEW.INI FILE DESCRIPTION** ....................................... 30
- **INDEX** ................................................................................. 31
DM-II™ Explorer Window

The Explorer Window shows all the information relating to the charts, user defined profiles, and datasets of a database. This window consists of two areas. The left side displays the Folder Box. This shows the Charts and the User Defined Profiles folders, as well as any Datasets that have been created in User folders. All of these folders are stored under the DM-II™ Database labeled at the top of the window. The right side is called the Folder Contents Box, which is used to show information related to the item selected.

![Diagram of DM-II Explorer Window]

- **Type:** User Defined Profile
- **Phase Type:** 102W
- **CT:** DMII
- **Memory:** 128K
- **Start Time:** When Start Pushed
- **Stop Time:** When Memory Full
- **Rate:** 1 Second
- **Interval:** 1.5 Minutes
- **Mode:** Normal
- **Parameters:** VRMS (RMSmax)
  - VRMS (RMSmax)
  - VRMS (RMSavg)
  - VPeak (L2 Power)

When datasets are available for viewing, the Folder Contents Box shrinks, and a Parameter List Box appears. This box shows parameters that have been recorded in the dataset from which a chart or data sheet can be generated.
By right clicking the mouse while either a chart, user defined profile, or dataset is selected, a Folder Box Popup menu will appear allowing the user to perform various functions. With a parameter selected, right clicking of the mouse will show a Parameter List Box Popup allowing the user to display a chart, data sheet, or parameter information.
Editing The Explorer Window

The names in the Folders Box can be renamed directly. To edit a name, the user selects an item and then presses the F2 key. This erases the name and enables editing for the item. Pressing the Escape key will abort the edit, and the name will revert back to the original name. Pressing the Return key, or the Up or Down Arrow keys before entering any other key will also abort the editing function. Pressing them after typing any characters will cause the name to be changed in the Explorer Window as well as in the database.

Note: Four items in the list can not have their names altered: DM-II™ Database, Charts folder, User Defined Profiles folder, and Factory Default Profile.
Downloading Data from the DM-II™

The DM-II™ needs to be linked to an available serial port of the personal computer via the RS-232 cable which is supplied. The DM-II™ RS-232 port is located at the top of the battery compartment. The RS-232 cable needs to be hooked up prior to attempting to downloading the data set. The first step is to connect the DM-II™ to your computer through a serial cable. The communications settings may need to be changed for the computer. To change the baud rate, the user selects Tools, then Options, and under the General page sets the appropriate Communications Port and Baud Rate. The Baud rate selection depends on the speed of the user's PC.

DM-II View™ To PC Serial Port Test: If the user selects Tools then Options then Port and then sets it to Auto, the DM-II View™ will automatically search for and select the proper communications port that the DM-II™ is connected to.

After the DM-II™ is connected to the computer, the DM-II™ should be set to the COMM SETUP screen. When the proper baud rate is selected, the DM-II View™ will show On Line in the Status Bar and the DM-II™ will flash Connection Okay. Allow sufficient time for verification of connection.

With the DM-II™ connected and responding, the user can start a download in the DM-II View™ software by selecting the Download Dataset option on the DM-II™ menu or by selecting it from the Tool Bar.

The download dataset option requires the user to give the new dataset a name and folder location. The user can also provide attribute information that will be saved with the dataset. The download monitor will appear after the download has been initiated. This will provide the user with the status of the download process.
Status Bar

The Status Bar informs the user of the connection status to the DM-II™ communications port settings, Tool Tips, time, and other software information.
Download Dataset

Download Dataset allows the user to download recorded data from the DM-II™ and place it in a database. There are two ways to initiate a download from the DM-II™: by selecting it from the DM-II™ Menu or the Tool Bar. The Download Dataset window appears if the DM-II™ is On-Line. This window allows the user to name the dataset and determine its location in the database. The location of where the data was recorded may be entered.

After entering the recording information, the user clicks the Download button which will display the download monitor. This informs the user of the progress of the download. The monitor displays the amount of bytes sent along with any errors that have occurred in the transfer process. The user can cancel the transfer at any time and the data will not be entered into the database. A progress bar displays the percentage of the download finished in the Status Bar.
A Updating Database window will appear showing a progress bar indicating percentage of database updated. The database is only updated with the downloaded data if a complete transfer has occurred.

Note: A large recording session that is downloaded to a slower machine will take time to update the database. Please wait until completed to assure complete access to the recorded data.
Repairing a Bad Database

A database can become corrupted on the disk. In some cases, the data can be recovered through the Repair Database function under Database Utilities of the Tools Menu.

Load Dataset from File

Load Dataset from File allows the user to download recorded data from a file. This option may only be selected from the DM-II™ menu. When selected, a window appears that allows the user to select a name and location for the dataset in a User Folder.

After entering the recording information, the user clicks the Fileload button which will display an Open Window. From this window, the user selects the location of where the file is stored. All stored files have a BIN extension. Pressing OK will then bring up the Update Monitor showing a percentage of database update.
Folder Box Popup

The Folder Box Popup menu provides right mouse-access to certain features of the application.

The following menu items are provided:

- **New** provides a sub menu in which to choose Folder or Chart.
  - **Folder** allows new folders to be created. New folders can only be created when a User folder or the DM-II™ Database is selected. Main folders are created when a new folder is added under the DM-II™ Database. A sub folder is created when a new folder is created under a User folder.
  - **Chart** brings up the Chart Properties window allowing the user to create a new chart.

- **Open** opens the selected item which can be a User Defined Profile, Chart, or Dataset.

  **Note:** Open is enabled only when a Chart, Dataset or User Defined Profile is selected.

- **Delete** allows the user to delete User Named Folders, Datasets, Charts and User profiles.

  The Delete function may also be selected by pressing the delete key on the keyboard. The Delete function is disabled on datasets that have saved charts linked to them. If a user desires to remove a dataset that has a connected chart they must first removed the charts that are connected.

- **Rename** allows the user to rename User Named folders, Saved Charts, Datasets and User Defined Profiles. This function is also available by pressing the F2 key.

- **Properties** provides information on Datasets and User Named Folders. This can also be accessed on the Tool Bar.
Parameter List Box Popup

The Parameter List Box Popup allows the user to produce a Chart or Data sheet from a dataset. In addition, properties of the dataset can be viewed.

- **Chart** displays the chart for the selected parameter.
- **Data sheet** displays the data sheet for the selected parameter.
- **Properties** show general information on the dataset.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>V1 RMS</th>
<th>V2 RMS</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Historical</td>
<td>Chart</td>
<td>Data Sheet</td>
<td></td>
</tr>
<tr>
<td>Event Cumulative</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Event Interval</td>
<td>V111</td>
<td>V11</td>
<td></td>
</tr>
<tr>
<td>Cumulative</td>
<td>V111</td>
<td>V111</td>
<td></td>
</tr>
<tr>
<td>Interval</td>
<td>Reactive Power</td>
<td>Apparent Power</td>
<td>True PF</td>
</tr>
<tr>
<td></td>
<td>V22</td>
<td>V22</td>
<td>Real Power</td>
</tr>
<tr>
<td></td>
<td>Reactive Power</td>
<td>Apparent Power</td>
<td></td>
</tr>
</tbody>
</table>
Tool Bar

The Tool Bar allows quick access to the more commonly used functions available from the menu bar. When the user passes the mouse over the Tool Bar selection, Tool Tips will appear to provide context sensitive help. ToolTips are also visible in the Status Bar.

Tool Tips

A Popup box will appear when the mouse is over a tool bar button. The popup box gives the function associated for that button.
Menu Bar

The Menu Bar provides access to all of the functions of DM-II View™. A pull down menu appears when one the menu items is selected with the left mouse button. The Alt key allows the user to use the keyboard to access a particular menu. The underlined character in each menu indicates access via a keyboard character. Shortcut keys are also provided to the right of each item in the pull down menu.

The following menus are provided:

- File Menu
- View Menu
- DM-II™ Menu
- Tools Menu
- Window Menu
- Help Menu

For Help, press F1.
File Menu

The File Menu provides access to functions that are used to modify the selected database. This menu is also used to exit the program.

The following menu items are provided:

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>DM-II</th>
<th>Tools</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Database</td>
<td>Open Database</td>
<td>Save Database As</td>
<td>Close Database</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open</td>
<td>New</td>
<td>Delete Del</td>
<td>Rename FZ</td>
<td>Properties</td>
<td></td>
</tr>
<tr>
<td>Save Chart</td>
<td>Print Chart</td>
<td>Exit</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **New Database** allows the user to create a new database.
- **Open Database** allows the user to open any available database. Clicking on this option will bring up a file dialog box to select available databases.
- **Save Database As** allows the user to save the open database under a different name.
- **Close Database** closes the open database. Repair can only be performed on a closed database.
- **Open** opens the selected item which can be a User Defined Profile, Chart, or Dataset. This is enabled only when a Chart, Dataset or User Defined Profile is selected.
- **New** provides a sub menu in which to choose Folder or Chart.
  - **Folder** allows new folders to be created. New folders can only be created when a User folder or the DM-II™ Database is selected. Main folders are created when a new folder is added under the DM-II™ Database. A sub folder is created when a new folder is created under a User folder.
  - **Chart** brings up the Chart Properties window allowing the user to create a new chart.
- **Delete** allows the user to delete Charts, User Defined Profiles, Datasets, and User folders.

The delete function may also be enabled by pressing the delete key on the keyboard.
The delete function is disabled on datasets that have saved charts linked to them. If a user desires to remove a dataset that has connected charts, they must first remove the charts.

- **Rename** allows the user to rename Charts, User Defined Profiles, Datasets, and User folders. This function is also available by pressing the F2 key.

- **Properties** provides information on Datasets and User folders. This can also be accessed on the Tool Bar.

- **Save Chart** allows the user to save a chart. This function only exists when a dataset has been charted.

- **Print** allows the user to print a chart or data sheet depending on which one is selected.

- **Exit** exits DM-II View™ software.
View Menu

The View Menu provides the user the ability to display the Tool Bar or Status Bar.

The following menu items are provided:

- Tool Bar
- Status Bar

- Chart Size selects the initial size for new charts before they are created. Chart sizes relate to the main window size. Example: ¼, the chart takes up ¼ of the main window.

DM-II™ Menu

The DM-II™ Menu allows the user to download a dataset, load a dataset from a file, or to create a User Defined Profile.

The following menu items are provided:

- Download Dataset
- Load Dataset from File
- User Defined Profile,
Tools Menu

The Tools Menu provides access to the database utilities and system options.

The following menu items are provided:

- **Database Utilities** provides a sub menu in which to choose the following:
  - **Backup Database** allows the user to backup a DM-II™ database.
  - **Repair Database** allows the user to repair a DM-II™ database.

  Note: The user cannot repair the currently loaded database. The database must be closed before a repair is attempted.

- **Compact Database** makes a rearranged copy of the database files and stores it on disk. Compacted files are usually smaller and often provide better performance.

- **Options**.

Window Menu

The Window Menu allows the user to view windows in various arrangements.

The following menu items are provided:

- **Cascade** allows the user to arrange the windows in a cascading fashion.

- **Refresh** allows the user to refresh the Explorer Window to its original state.
Help Menu

The Help Menu provides access to the Help dialogue. The following menu items are provided:

- **Contents** displays the contents of the help file.
- **Search For Help On** allows a search for function description or definition in the help file.
- **Technical Support** displays information on how to get technical support.
- **The About DM-II View™** shows general information about this application software.
Creating a Chart

Creating a Chart can be accomplished several different ways. The quickest method is to first select the desired parameter in the parameter list box. Right clicking the mouse will bring up a Parameter List Box Popup menu from which the user selects the chart function.

An alternative method is to right mouse click on the dataset which will bring up the Folder Box Popup menu from which the user can select New and then Chart. This will bring up the Chart Properties window. The user then selects the desired parameters from the left hand list. The user can then decide to create the default chart with the selected parameters or make changes to the chart layout. The chart will then be displayed by clicking on the OK button. The user may also open a previously created chart by right mouse clicking the selected chart in the Folder Box.

Resulting Chart

Once the chart is displayed on the screen it can be printed, saved in the database, modified, or closed.

Printing or saving the chart can be done by selecting Print or Save Chart from either the Tool Bar or from the File menu.
Chart Information

The Chart function displays data for the user to view and/or print. Scrolling through the data can be accomplished by using the arrow keys or the mouse. The upper left corner of the chart displays the time and date at the location of the scroll bar. The minimum and maximum values of the data set are also displayed. Point refers to measured value of data at the scroll bar. If the data consists of all zeros, no scroll bar is present.

Scroll Bar  Scroll Position

After the chart is displayed, items are automatically added to the tool bar. They are Zoom In, Zoom Out, Normal Zoom, Increase Gain, and Decrease Gain. The zoom items change the range of the values on the X-Axis on the chart. The zoom items are also added to the menu bar for access with a mouse. The gain items change the range of the values on the Y-Axis of the chart. The gain function is only available on the tool bar.

DM-II View

File  View  DM-II  Tools  Window  Help  Zoom

Zoom In  Zoom Out  Decrease Gain
Normal  Increase Gain
Zoom
Chart Properties

The Chart Properties form allows the user to customize the setup of the chart's display. Several pages are available allowing the user to adjust different chart characteristics.

The Parameters Page allows the user to select which parameters of the dataset to display. Multiple parameters from the same dataset may be selected to be displayed on the same chart. The Properties selection shows general information of the selected parameter. Clicking on Data Sheet will bring up the data sheet.
The Axis Page allows the user to change fonts, text, orientation, and placement of axis labels. The axis labels can also be removed from the chart by using the 'Is Showing' check box.
The Chart Group page allows the user to edit the legend data. The legend can also be eliminated by deselecting the Show Legend checkbox. The Group selection relates to the two Y axis on the chart.
On the Titles Page the user can edit the displayed titles, change the font of titles, and adjust their placement. The titles can also be turned off from the chart by deselecting the Is Showing checkbox.
Data Sheet

The Data Sheet displays the data of a parameter in tabular format.

The user may select any parameter of the dataset to be displayed.
The user can adjust how the data is viewed by using the scroll bar. The scroll bar arrows adjusting the displayed data to the top or bottom of the dataset, one page at a time, or one line at a time. The user can also move through the data by using the arrow keys and the page up or page down keys.

Clicking on the Chart button will produce a chart of the selected parameter, unless the parameter has only a single data point. Clicking on the Goto button will bring up the Goto window. This allows the user to quickly move through the data to a particular point. The Method choice allows the user to jump to a point in the data sheet based on the row number or time. The Goto point may also be scrolled to by using the mouse or the Right or Left arrows.
User Defined Profiles

This window allows the user to configure the DM-II™ for a data recording session.

The Setup page allows user to select phase type, time settings, and hardware settings. Once setup is selected, the user can load the profile to the DM-II™ by clicking the Send button. The Start and Stop buttons control the recording session on the DM-II™. Send, Start, and Stop will only work when the DM-II™ is On-Line. Save allows the user to save the profile to the database.
Options

The Options selection allows the user to change the look and operation of the DM-II View™ software.

Options

- Database Backup:
  - Do not prompt for database backup
  - Prompt to backup database on open
  - Prompt to backup database on close

- Default User Defined Profile:
  - Factory Default

- Communications:
  - Port: Communications Port (COM1)
  - Baud: 19200

The General Page has settings for the communications port, profile default settings and backup prompt options. Clicking OK or Apply causes the changes to be updated in the DM-II View™ software.
The Explorer View Page allows users to change the font type, size, and color used in the explorer screen. The selected font is displayed.
DMIIVIEW.INI File Description

This section contains information about the application that will be stored in the DMIIVIEW.INI file.

This file is created when software is installed and updated with option changes during running of software. This file is located in the Windows directory. Changes can be made by user directly.

Caution: Manually changing these settings might cause DM-II VIEW™ software to not operate properly.

INI Sections/Keywords Description

[Application]
CurrentDB = Current Database being used.
User Name = User name entered during installation.
User Organization = Company name entered during installation.
AppPath = The directory where the DM-II View™ software is loaded.
User Product Number = Product identification number (Version and Release information).

[General]
ShowToolBar = -1 Tool Bar displayed? -1 = yes, 0 = no
ShowStatusBar = -1 Status Bar displayed? -1 = yes, 0 = no
ShowToolTip = -1 Display Tool Tips? -1 = yes, 0 = no
DBBackup = 2 Prompt for when Database Backup occurs
Language = 1 0 = at program start, 1 = at program close, 2 = No Prompt
English = 1

[Position]
FormTop = 0 The starting location of the MDI application.
FormLeft = 0 The starting location of the MDI application.
FormHeight = 8520 The starting size of the MDI application.
FormWidth = 11850 The starting size of the MDI application.
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
</tr>
<tr>
<td>Chart Information .............................................................. 20</td>
</tr>
<tr>
<td>Chart Properties ................................................................. 21</td>
</tr>
<tr>
<td>Creating a Chart ................................................................. 19</td>
</tr>
<tr>
<td>D</td>
</tr>
<tr>
<td>Data Sheet ............................................................................. 25</td>
</tr>
<tr>
<td>DM-II Explorer Window ............................................................. 2</td>
</tr>
<tr>
<td>DM-II Menu ............................................................................. 16</td>
</tr>
<tr>
<td>DMIIView.ini File Description .................................................. 30</td>
</tr>
<tr>
<td>Download Dataset ..................................................................... 7</td>
</tr>
<tr>
<td>Downloading Data from the DMII ............................................... 5</td>
</tr>
<tr>
<td>E</td>
</tr>
<tr>
<td>Editing The Explorer Window ................................................... 4</td>
</tr>
<tr>
<td>F</td>
</tr>
<tr>
<td>File Menu .............................................................................. 14</td>
</tr>
<tr>
<td>Folder Box Popup ..................................................................... 10</td>
</tr>
<tr>
<td>H</td>
</tr>
<tr>
<td>Help Menu ............................................................................. 18</td>
</tr>
<tr>
<td>L</td>
</tr>
<tr>
<td>Load Dataset from File ............................................................ 9</td>
</tr>
<tr>
<td>M</td>
</tr>
<tr>
<td>Menu Bar ............................................................................... 13</td>
</tr>
<tr>
<td>O</td>
</tr>
<tr>
<td>Options ............................................................................... 28</td>
</tr>
<tr>
<td>P</td>
</tr>
<tr>
<td>Parameter List Box Popup ....................................................... 11</td>
</tr>
<tr>
<td>T</td>
</tr>
<tr>
<td>Tool Bar .............................................................................. 12</td>
</tr>
<tr>
<td>Tools Menu ........................................................................... 17</td>
</tr>
<tr>
<td>U</td>
</tr>
<tr>
<td>User Defined Profiles .............................................................. 26</td>
</tr>
<tr>
<td>V</td>
</tr>
<tr>
<td>View Menu ............................................................................ 16</td>
</tr>
<tr>
<td>W</td>
</tr>
<tr>
<td>Window Menu ......................................................................... 17</td>
</tr>
</tbody>
</table>